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What’s New in V9.5 

1 New General Features 

1.1 CAM Layers Enhancement 
When the part contains only one CAM layer, CAM Layers dropdown list is disabled on the 
State Bar. 

 

1.2 Manual Nesting  
Closing either of the Ask Part or the Instance Data commands is equivalent to exiting the 
command.  
In former cncKad versions closing either of these commands would still leave you in them. 

1.3 Remove Wire Joint Command 
This new command in the CAM Menu allows you for removing the Wire Joint command, 
avoiding the removal of punches/cuts. 

 

1.4 Rotation Angle in Polygon Shape 
The Polygon Shape option in the Draw Menu allows you to enter the desired Rotation 
Angle of the polygon and place it on the drawing already rotated. 
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For the above entered parameters, the polygon we place on the geometry will look this way: 

 

1.5 Shape List Support in Report File 
Now it is possible to implement the Shape List from Draw Menu into the Report File. 

1.6 Changes in Printing  
From now on, on Printing Tab of Workspace Settings you will be able to set the minimal 
size (in pixels) for printed small shapes. This way they will always be visible on the paper.  

 

1.7 Support For Black/White Printing From Simulation 
Now it is possible to print the drawing in black and white in Simulation module. 
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1.8 Saving Files on Exiting cncKad 
When you exit cncKad and a Part/Nest needs to be saved, cncKad will display it before 
prompting the user to save it. 

1.9 Push Out Icon Has Been Added 
There is a new Push Out Icon in CAM Menu, providing you with easy access to the Push Out 
dialog: 

 

1.10 DXF Export Support for TRUMABEND 
Now it is possible to export drawings as a DXF format to TRUMABEND Trumpf Machines. 

5 



cncKad.95 

2 New Punch Features 

2.1 Linear Turret Support 
In version 9.5 it is possible to define a Linear: 

 
 
And a Turret Setup as well: 

 
Linear Turrets are useful for machines such as Buss-Bar, Coil, and even some standard 
machines such as the Amada OCTO. 
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2.2 Spaces In Turret Naming  
If you create a new turret and give it a name that contains spaces, the spaces will be 
converted to '_', e.g:  “my turret” => “my_turret”. 
 
In the following example we saved a turret name containing spaces: 

 
 
And they were converted into "underscores": 

 

2.3 Automatic Process AutoDestroy Sheet  
A new automatic process supports destroying the sheet completely, leaving only a strip at the 
clamps. 
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2.4 Trim Sheet Changes 
Now it is possible not only to trim a sheet with a laser tool, but by choosing the Side by Side 
option you can choose more than one side of the sheet to be trimmed. 

 

2.5 Wire Joints Support For Arcs and Circles 
In Add Punch dialog you can now add Wire Joints for arcs and circles. 
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And this will be the result on the drawing: 

 

2.6 AutoPunch Support For Arcs and Circles 
Arcs and Circles can now be automatically processed by rectangular tools, using the Prefer 
rectangular Tools for Arcs/Circles option from AutoPunch Parameters tab of AutoPunch 
dialog: 
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2.7 Use Oval Tools for Slitting 
This new option of Slitting tab of AutoPunch dialog enables the user slitting the sheet with 
oval tools. 

2.8 New Tool Options 
There are new features for handling tools: 

2.8.1 Curving Tool Support For Trumpf 
cncKad provides Curving Tool support for Trumpf Machines. 

2.8.2 Changes in Tapping Tool Properties 
In the Type Properties tab of Tool Data dialog of Tapping Tool a new section was added, 
containing additional information for tapping tools: 
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2.8.3 Warnings For Special Tools 
Over Tonnage and Destroying the Part Warnings are no longer valid for Wheel, Tapping 
and Forming Tools. 

2.8.4 MultiTool Rotation  
A new Key in the MDL file allows controlling the amount of MultiTool rotations near Sheet 
Edge. 

11 



cncKad.95 

3 New Laser Features 
  

3.1 Vaporize Foiled Sheet 
In the Cutting Parameters tab in Set Sheet and Clamps dialog you will find Vaporization 
features, allowing you to work more efficiently.  
Here you can choose whether to vaporize the entire sheet, a single cut or a pierce, before 
processing the sheet with cutting.  
In the past you could only set these options by adding vaporizing functions before the cut. 
Now you can define in one place both their sequence and the vaporizing area: 

 

3.2 Path Finder (Adjust Tool-Path) 
This automatic option calculates a path from one hole to another, avoiding passing over 
already cut holes.  
In the following examples you can see the utilization of this function: 

• Before: 
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• After: 

 
 
Before:     

 
After: 

3.3 Handling Texts and Points in AutoCut 
Now there is an option for the automatic handling of texts and points in the Technology tab of 
AutoCut dialog.  
Whatever choice you make, when cncKad recognizes unprocessed text or unmarked point it 
will take action according to these definitions: 
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3.4 No "Auto Tool Order" in Part Unloader 
The Auto Tool Order option in Part Unloader doesn't apply for cutting. 
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4 New in Tube Cutting 

4.1 New Tube 3D Viewer 
The 3D Viewer can now display edge cuts that were added manually, and not through Create 
Intersection dialog. 
This is an example of such a manual modification: 

 
 
and here is its 3D representation: 

 

4.2 Enhancement For Tubes Intersection 
An intersection with a rectangular profile can now be done with a corner radius of 0. 

4.3 New Model Key For Tubes 
The "LimitAngleForPlaneCutting" key, inserted into .MDL file, sets the limits of the laser 
movement for planar cuts, so that the beam doesn't stray away from the tube.  
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5 New in AutoNest 

5.1 AutoNest is Now an MDI Application 
 MDI is an acronym for Multiple Document Interface.  

This means that it is possible to open as many files as needed in main AutoNest window: 

 
 
In addition to that, you can switch between the open parts from the new Window Menu, as 
well as Tile, Cascade, etc:  

 
 
There are also new features in the File Menu, allowing you to Save/Close not just one 
window, but all of the windows at the same time: 
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5.2 Blanking in AutoNest 
Blanking is the option of filling empty spaces in the nests. It is accessible from Nesting 
Menu: 

 
 
In the Create Blank Parts dialog you can enter various parameters for future space-fillers: 
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The result will be similar to the one presented below: 

 

5.3 Parts Priority in AutoNest 
In the Part Information dialog chosen from Part Menu you are able to assign a Priority to a 
part, giving an appropriate number: 
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While running Start/Continue AutoNest option you will be able to choose whether to Use 
Part Priority or not.  
If you choose to utilize this during subnest creation, you will be able to decide how to handle 
the priority – for new or already nested sheets: 
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5.4 Labels Report 
Now it is possible to create Labels Report from Settings => Report Settings  => AutoNest 
Labels Settings: 

 
 
Later on you will be able to print preview and print a Labels Report: 

 
 
That's how the printout will look like:  
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You can also create labels with bar code: 

 

5.5 New Tokens in AutoNest 
A few new tokens such as P_WEIGHT_GROSS and P_WEIGHT_GROSS_SN have been 
added to AutoNest. 

5.6 Reports' Print Preview for Several Subnests 
It is possible now to view Reports' Print Preview for several subnests at a time. In previous 
versions this option was available only for printing: 
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After the reports are created you will receive the following message: 

 

5.7 New Default Exported Filenames Template 
In Working Settings on the AutoNest tab you will find new templates of Exported File 
Names: 

 
 
When you export parts from AutoNest to cncKad, choosing one of the following templates 
from dropdown list will determine the exported files naming in cncKad: 
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5.8 Changes in DFT Files Creation 
Each part imported to AutoNest has its own description (in available in Part Information 
dialog): 

 
 
If in your nest there are two or more parts with the same description, in Part Information 
dialog you can change their description before creating DFT files for them. 

5.9 Divide Button Added to Parts List dialog 
In the Part List dialog a divide button was added: 

 

5.10 Change Subnest’s Material 
Now it is possible to change materials for chose subnests. Select the subnest for which you 
want to change material, and click the right mouse button. In the dialog which will appear you 
will be able to choose Change Material option: 
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Clicking it will result in opening the following dialog, from which you will be able to pick your 
subnest's new material: 

 

5.11 Efficiency Calculation Considers AutoCutSheet 
Efficiency calculation takes unto the consideration the used space of the sheet space cut with 
AutoCut Sheet option: 

5.12 Rotation Placements 
When you move a part while placing it on the nest you can rotate it using "+" and "-" buttons.  
This allows you for more efficient space usage and is more accurate placing tool.  
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6 Estimation Module 

6.1 Cost Estimation Support for Nest 
There is a new item of Estimation Menu provides costing and timing estimation not only for 
Current Part, but for Current Nest as well.  

 

6.2 Gas Pricing in Time Estimation Settings 
For cutting machines there is a new item of Gas Prices on General Tab in Time Estimation 
Settings: 

 

6.3 Changes in Estimation Dialog 
There are a lot of changes implemented to Estimation Dialog. Its outlook changed completely 
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– instead one huge window you will see tabs sorted according to their content: 

6.3.1 Estimation Summary Table 
The estimation data appears both in a summary table that describes the main information for 
each part, and additional summary information related to the entire nest such as: total 
efficiency of material usage within the nest and the material cost for each part in the nest, 
derived from the calculated efficiency. 

 

6.3.2 Single Part Costing 
Single part costing mode provides the ability to estimate the part in a “stand alone” mode (i.e. 
not as a part of the nest). This option is available also for a single DFT geometries. 
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6.3.3 Part Processing 
Here you can see the processing time details for each part in the geometry. 

 

6.3.4 Part Extra Work 
This tab allows the user to setup the extra processing types and estimate their time and cost. 
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6.3.5 Machine 
This tab provides you with the information on the machine you work with – its working data 
and technology parameters. 
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7 New in CAD Link 

7.1 New functions in SolidWorks and SolidEdge 
In SolidWorks and SolidEdge there are two to new functions to traverse assemblies or single 
parts silently: SW_StartTraverseWithOptions and SE_StartTraverseWithOptions. They are 
accessible through the PartReader automation interface. They allow the programmer to export 
entire assemblies from the Solid program to cncKad without requiring intervention from the 
user. 

7.2 SolidEdge Assembly Enhancement 
There is a new function in SolidEdge Assembly, allowing you to open Settings Dialog directly, 
instead of entering Material Properties dialog first. 
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